
1 U.S. Department of Health & Human Services | National Institutes of Health 

SOP340548: Image Extraction and Analysis of Tumor Biopsy Slides for EMT Panel IFA 

Effective Date: 6/16/2020 

Please check for revision status at 
http://dctd.cancer.gov/drug-discovery-development/assays/validated-biomarker-assays

and be sure to use the current version. 

TABLE OF CONTENTS 

TABLE OF CONTENTS ...........................................................................................................................................1 

OVERVIEW OF EMT PANEL IMMUNOFLUORESCENCE ASSAY FOR BIOPSIES .......................................3 

1.0 PURPOSE ......................................................................................................................................................4 

2.0 SCOPE ............................................................................................................................................................4 

3.0 ABBREVIATIONS ........................................................................................................................................4 

4.0 INTRODUCTION ..........................................................................................................................................5 

5.0 ROLES AND RESPONSIBILITIES ..............................................................................................................5 

6.0 MATERIALS AND EQUIPMENT REQUIRED ..........................................................................................6 

7.0 OPERATING PROCEDURES.......................................................................................................................7 

8.0 QUALITY CONTROL, DATA ANALYSIS AND REPORTING ..............................................................43 

APPENDIX 1: BATCH RECORD ..........................................................................................................................47 

APPENDIX 2: CONTROL SLIDES AND CLINICAL SLIDES LAYOUT ...........................................................48 

APPENDIX 3: BLANK DATA REPORT GENERATED IN THE TEMPLATE MASTER .................................50 

APPENDIX 4: EXAMPLE OF A COMPLETED DATA REPORT GENERATED IN THE EMT TEMPLATE 
MASTER ..................................................................................................................................................................54 

APPENDIX 5: SAMPLE DATA REPORT CALCULATIONS..............................................................................58 

APPENDIX 6: LIST OF HEADER FOLDER CONTENTS & LIST OF SETTINGS (EXPORT A 
SCREENSHOT) IN DEFINIENS ............................................................................................................................59 

APPENDIX 7: NAMING ANNOTATED ROI .......................................................................................................60 

https://dctd.cancer.gov/ResearchResources/ResearchResources-biomarkers.htm
http://dctd.cancer.gov/drug-discovery-development/assays/validated-biomarker-assays


2 U.S. Department of Health & Human Services | National Institutes of Health 

VERSION INFORMATION 

1. Approvals

2. Change History



 

3 U.S. Department of Health & Human Services | National Institutes of Health 

OVERVIEW OF EMT PANEL IMMUNOFLUORESCENCE ASSAY FOR BIOPSIES
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1.0 PURPOSE 

The purpose of this SOP is to standardize an immunohistochemical method for detecting and quantifying 
epithelial-mesenchymal transition (EMT) markers in formalin-fixed, paraffin-embedded tumor biopsy 
sections to support clinical trial pharmacodynamic (PD) studies.  The EMT Panel includes E-Cadherin 
and Vimentin, with β-Catenin for tumor segmentation.  The goal of the SOP and associated training is to 
ensure consistency of measurements, and to standardize the reporting of PD data for EMT 
Immunofluorescence Assay (IFA) measurements. 

 
2.0 SCOPE 

This procedure applies to all personnel involved in the use of the EMT Panel IFA for tumor biopsies from 
patients participating in clinical trials.  This SOP outlines the recommended procedure for image 
extraction and quantitation of EMT-stained, paraffin-embedded tumor biopsy sections.   

 
3.0 ABBREVIATIONS 
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4.0 INTRODUCTION 

The EMT Panel IFA was developed to quantitively evaluate epithelial (E-Cadherin positive), 
mesenchymal (Vimentin positive) and transitional (colocalization of Vimentin and E-Cadherin) 
phenotypes in tumor tissue sections.  In some cancers, high levels of Vimentin and low levels of E-
Cadherin have been associated with a poor prognosis.  

This assay is designed to detect, quantify, and analyze changes in the amounts of cellular markers 
Vimentin, E-Cadherin, and their transitional overlap in biopsied tissue in support of PD clinical trials.  
The tissue biopsies are collected at different time-points, usually pre-dose and post-dose. The assay 
detects E-Cadherin and Vimentin using monoclonal antibodies that are directly conjugated to Alexa Fluor 
immunostaining reporters. To define the area of the tumor tissue within which markers are quantitated, a 
pathologist annotates the viable tumor areas within each biopsy. In addition, β-Catenin staining is used to 
better define tumor cells from surrounding normal tissue, such as stroma, which also expresses significant 
levels of Vimentin.  It is imperative to segment tumor regions using β-Catenin to preclude 
measuring Vimentin from normal mesenchyme.    

Detailed information regarding the development, validation and application of this assay has been 
described in: Navas, T. et al, Clinical evolution of epithelial-mesenchymal transition in human 
carcinomas. Cancer Res. Nov. 15, 2019. 

 
5.0 ROLES AND RESPONSIBILITIES 

Laboratory Director/Supervisor The Laboratory Director/Supervisor, directs laboratory operations, 
supervises technical personnel, reporting of findings, and is responsible 
for the proper performance of all laboratory procedures.  The Laboratory 
Director/Supervisor oversees the personnel running SOPs within the 
laboratory and is responsible for ensuring this person(s) is certified and 
has sufficient experience to handle clinical samples. 

Certified Assay Operator  The Certified Assay Operator may be a Laboratory 
Technician/Technologist, Research Associate, or Laboratory Scientist 
who has been certified through DCTD training on this SOP.  The Assay 
Operator works under the guidance of the Laboratory 
Director/Supervisor.  This person, in accordance with the current SOP(s), 
performs laboratory procedures and examinations and any other 
procedures conducted by a laboratory, including maintaining equipment 
and records and performing quality assurance activities related to 
performance.  

 It is the responsibility of the Laboratory Director/Supervisor to ensure that all personnel have 
documented training and qualification on this SOP prior to the actual handling and processing of 
samples from clinical trial patients.  The Laboratory Director/Supervisor is responsible for 
ensuring the Certified Assay Operator running the SOP has sufficient experience to handle and 
analyze clinical samples. 

 The Certified Assay Operator for this SOP should be well versed and comfortable with light 
microscopy techniques, slide scanning techniques, as well as have familiarity with the Definiens 
Tissue Studio Software for image analysis. 

 The Certified Assay Operator responsible for conducting the assay is to follow this SOP and 
complete the required tasks and associated documentation.  The Batch Record (Appendix 1) must 
be completed in real-time for each experimental run, with each page dated and initialed, and 
placed with the clinical sample information.   
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 All responsible personnel are to check the DCTD Biomarkers website 
(https://dctd.cancer.gov/ResearchResources/ResearchResources-biomarkers.htm ) to verify that 
the most recent version of this SOP is being used. 

 

6.0 MATERIALS AND EQUIPMENT REQUIRED 

 Aperio eSlide Manager Leica Biosystems software 

 Aperio ImageScope software (version 12.4.2.5010 or higher) 

 Definiens Architect XD 64 version 2.7.0; Tissue Studio Analysis software version 4.4.3 

 EMT Solution version 2.7 

 Microsoft Excel software (Excel for Office 365 or higher – with Developer ribbon enabled) 

 Computer operating system - Windows 10 or higher 

 Whole slide images of stained clinical sample and control slides that are imaged according to 
SOP340547 and stained according to SOP340546 

 SOP340548 Microsoft Excel EMT Master Template version B 

 Workstation with at least 32.0 GB memory, 64 bit operating system, 4 cores, 8 logical processors, 
and speed of 3.1 GHz. Must be capable of running at least 2 UHD monitors.  

 

https://dctd.cancer.gov/ResearchResources/ResearchResources-biomarkers.htm
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7.0 OPERATING PROCEDURES 

 The Batch Record (Appendix 1) for image analysis should be completed to document image 
extraction and analysis for each patient from a Bond-RX staining run. 

 Record the Facility/Lab Name, Assay Operator performing the image extraction and 
quantitation, and the date(s) of analysis. 

 Record the Patient ID, Tissue ID(s), CTEP Protocol#, Calibrator Lot#, Calibrator Image 
ID(s), and Patient Slide# in the Batch Record.  

 After completing Definiens analysis, record marker thresholds for the calibrator and 
patient images in the Batch Record.  Record also the name of the header folder and its 
location (the EMT Master Template /Data Report must be saved in the header folder).  

 Comments on extraction and analysis of individual slides or images can be made in the 
Comments section of the batch record.  

 The Batch Record must be signed and dated before the record is submitted.  

 Preparation for annotation and extraction of slide images located on the Aperio eSlide 
Manager database.  

Note: See Appendix 2 for control and clinical slide section orientation.   

 Initiate Aperio ImageScope. 

 Access each clinical slide within the clinical eSlide Manager database, and open 
individual images using Aperio ImageScope following these steps and referring to the 
associated screenshots shown below:  1) Login into Aperio eSlide Manager; 2) Click 
Continue button; 3) Click the Cases icon; 4) Click the file icon next to the case of 
interest; 5) Click on the brain icon next to the patient of interest; 6) Open the digital slide 
by clicking once on the slide image. The slide image should be opened in ImageScope. 

1) Login with username and password. 

 
 

 

 

 

 



 

8 U.S. Department of Health & Human Services | National Institutes of Health 

2) Click Continue button. 

 
3) Click the Cases icon. 

 
4) Click the file icon next to the case of interest. 
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5) Click the brain icon. 

 
6) Click on slide image to open digital slide in ImageScope.  

 
 

 Clinical data within NCTVL at FNLCR must be stored in the CLINICAL folder.  For 
each patient, create one header folder on the Definiens Drive: Definiens Image Upload > 
PADIS > CLINICAL > Specific Trial folder > EMT.  The suggested naming convention 
for this header folder is: CTEP protocol number_patient ID.  Example:  Definiens Image 
Upload Y: PADIS\CLINICAL\9510 \EMT\9510_1010001.  See Appendix 6, Section 1 
for a recommended list of header folder contents. 

 For each EMT control slide, create a folder within the specific CTEP/patient header 
folder.  Name the folder as “EMT Cal CTEP protocol number_patient number(s)” (more 
than one patient may be run with a single control slide).  Example: EMT Cal Images 
9659_ 25_30_31.  

 Tissues visualized in Aperio ImageScope software are given a “false” color assignment 
for each biomarker: E-Cadherin signal is assigned green (Alexa Fluor 488), Vimentin 
signal is assigned red (Alexa Fluor 660), β-Catenin signal is assigned yellow (Alexa 
Fluor 546) and DAPI signal is assigned blue. 

 General requirements for the annotation and extraction of images from clinical slides: 

 For clinical tissues, select as many regions of interest (ROIs) as necessary to 
adequately cover the entire analyzable area, up to 30 images per tissue/slide, 
using the pathologist annotated H&E image as a guide.  In addition, ROIs should 
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be in clear focus on the stained slides.  If large areas of a tissue are not in focus, 
the tissue cannot be analyzed, and the slide should be re-scanned.  ROIs should 
cover only the analyzable areas for the clinical tissues, and avoid areas with 
necrotic or normal cells, large gaps, tissue folds, nonspecific staining or debris.  

The number of ROIs to be examined per sample will depend on the total area 
annotated by the pathologist as containing tumor cells and the size of the viable 
tumor regions.  An example of a pathologist’s annotated H&E image is shown 
below.  ROI annotations should not overlap.  A minimum of at least 2 
nonadjacent slides must be analyzed for each patient.  Each biopsy pass must 
have at least 3000 analyzable nuclei over 2 slides for the data to be reported.  

 

 β-Catenin has been shown to permit delineation of tumor tissue from surrounding 
stroma and normal tissue in many carcinoma biopsies and in some sarcoma 
biopsies (see published reference in Section 4.0).  All ROIs extracted for analysis 
from the pathologist-annotated areas should be confirmed to be positive for β-
Catenin.   

The intensity profile of the β-Catenin signal can be adjusted to optimize 
visualization.  To adjust the β-Catenin signal, follow these steps, and refer to 
image below: Click the Image from toolbar, then select Fusion Adjustment from 
the drop-down menu. In the pop-up box, turn off all colors except yellow by 
clicking on eye icons next to the colored boxes, then adjust brightness, contrast, 
and gamma until the desired intensity is achieved. After the adjustment, turn all 
colors back on by clicking on the eye button on the top.  
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 The intensity of the measured biomarkers Vimentin and E-Cadherin should not be 

adjusted for patient images.   

 For EMT control slides, select at least 5 different ROIs with a maximum of 10 
ROIs per control tissue, and avoid regions of necrosis (as indicated by rounded 
up nuclei).  In addition, extract one glass only or tumor with glass field to 
facilitate tumor segmentation by DAPI.  For control materials only (NOT FOR 
CLINICAL SLIDES), ROI selection is guided by where the marker is 
present in the control tissue.  Vimentin (Fluor 647) and E-Cadherin (Fluor 488) 
intensity can be adjusted to help guide ROI selection only for control images.  

 Image Annotation 

 Prior to image extraction, the image fields to be extracted are selected and annotated. 

 The rectangle tool, as shown below, is used to draw boxes over the target areas.  The size 
of the rectangle can be automated by selecting: Tools > Options > Annotations.  Use 
1000 for the height, width and length fields.  
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Simultaneously holding down the keyboard control (Ctrl) button and clicking the 
rectangle tool (shown below) will automatically create a 1000 x 1000 annotation box, 
which will allow for faster field selection.  If the placement of the annotation box needs 
to be adjusted, hold down the keyboard Ctrl button and move the box to the desired 
position.  

Tool bar with retangle tool. 

 
Each annotated ROI is named in ImageScope as follows: Project (5 digits), (underscore), 
Patient ID (4 digits), (space), Specimen ID (4 digits), (space), Slide, (space), Slide# (3 
digits), (space), timepoint (5 digits), (space), ROI# (2 digits). For any number with less 
digits than required, add zeros in front of the number to make up for the requirement. 
Example: 09659_0029 502D Slide 015 C1D08 01.   

The annotated ROIs are named by typing the desired text in the Text box in the Layer 
Regions of the Annotations - Detailed View window following these steps and 
referring to images below: 1) Open the Detail View window by selecting View > 
Annotations (make sure that the View Standard Toolbar is selected).  If the Summary 
View Annotation window is open, select the Details button to switch to Detailed View. 
2) In the Layer Regions of the Detailed Annotation window, widen the Text selection 
and enter the appropriate annotation names; 3) Save the annotations by clicking on the 
Save button.  See an example screenshot of annotated image below.  
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1) Open Annotation Detailed View box. 

 

 
2) Enter annotation names in the Layer Region of the Annotation Detailed View box. 
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3) Save the annotations.  

 
 

4) An example screenshot of pre-treatment tissue with annotations. 

 
 Image Extraction 

 Each annotated ROI is extracted as an SVS file (JPEG2000 file) and saved to the 
Definiens drive, as described below. 

 Select a region of the tumor and zoom in with a magnification of at least 4X.  Use the 
Extract Tool button (as shown below) to place the extraction box over the annotated 
region of interest. 
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 If the Extraction image tool button is not located on the toolbar, go to the View tab and 

select the View Standard Toolbar from the menu, as shown below.  
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 An Extract Image Region dialog box will appear (as shown below in section 7.4.5.1).   

 Note: The dimensions of the extracted regions do not need to be kept fixed since 
the E-Cadherin or Vimentin marker area will be normalized to the total tissue 
area or the total number of cells or nuclei in the extracted ROI.  However, to be 
consistent and to reduce variability, 1000 x 1000 box size will be used. 

 To name the file, select Output File in the dialog box (as shown in step 1 below) and 
save the image to the appropriate header folder on the Definiens drive.  Each ROI is 
given a file name, and each file should be put in the header folder > CTEP 
protocol_patient ID Extracted Images (as shown in steps 2-4 below).  File name for each 
image should follow the annotation naming criteria.  After naming the image, click Save 
button, then press Extract button in the dialog box.  Once the region is extracted, press 
Close to exit the dialog box (as shown in steps 5-6 below).  Move on to the next region 
to be extracted.   

 Note: It is important to strictly follow the naming convention as detailed for 
annotation naming in section 7.3.2.  The exact nomenclature will enable proper 
export of Definiens data, and calculations within the EMT Master Template file.   
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 When image extraction is complete for all images acquired per patient (pre- and post-
dose tissues), zoom out to view the entire tissue and use the snapshot tool to save a 
snapshot of each annotated image.  Save the snapshots of the biopsy tissue in the header 
folder.  

 After image extraction is completed, close the ImageScope software and log off the 
Aperio eSlide Manager database. 

 

 Initial Definiens Image Analysis 

 Open Definiens Tissue Studio software (Architect XD version 2.7.0 -Tissue Studio IF 
version 4.4.3). 

 
To import the folder containing the extracted Aperio images, select Import Folder 
option in the Load tab as shown below.  Use the Browse option to select the folder 
containing the extracted SVS images to be analyzed.   
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 A screenshot of the Import Folder dialog box is provided below.  Calibrator tissue must 
be analyzed separately from patient specimens, and biopsies from each patient must be 
analyzed individually due to morphological differences.  Therefore, load only images 
from one patient or from a calibrator. 

 
 In the next screen, from the drop-down menu under Select Scanner Type, choose 

“Aperio Scan Scope FL-with resolution”.  Press Next. 

 In Workspace Name field on the next screen, create a workspace analysis folder name 
as shown below.  The workspace name must contain the CTEP protocol number and the 
patient ID.  In Select Workspace Storage Location, browse and select folder where the 
SVS images are stored.  Press Finish.   
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 Select and highlight 12 images from the imported image file and define them as a 
training set.  Make sure to include images from all timepoints.  To select images, hold 
down the Ctrl key on the keyboard and left click until 12 images have been chosen.  The 
selected images will be highlighted in blue, as shown below.  Load the training image set 
by right clicking on the screen and selecting Define Training Data Set on the pop-up 
menu.  Using the maximum number of images (12) and including images from all the 
time points for the training set is important in order to get the best results for tissue 
segmentation and marker thresholding.  

 

 
   

 Under the Configure tab (shown below), select Load Solution.  In the pop-up Load 
Analysis Solution box, browse to Definiens Image Upload “fr-s-dtp-378apr) > PADIS > 
Solutions folder, select file EMT V2.7 2-_20_2020.dax and click OK (refer to images 
below).  This Definiens solution is the default setting for analysis of control tissues and 
clinical samples for EMT IFA PANEL.  It is designed to segment the tumor tissue and 
exclude normal tissue that could interfere with or dilute the analysis.   
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 After loading the solution, adjust the image layer mixing to assign colors to layers by 
going to View > Image Layer Mixing.  In the Edit Image Layer Mixing popup box, 
assign correct colors to each marker as indicated below and then click OK to accept 
changes. 
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 In the Analysis Builder menu, confirm General Settings for the solution are correct as 
outlined below. 

Under Image Information Settings: 

Magnification 20X 

Magnification (um/pixel) 0.4622 

Bit depth 16-bit 

Edit names Make sure layers are assigned correctly:  

Layer 1: Vimentin 

Layer 2: β-Catenin 

Layer 3: E-Cadherin 

Layer 4: DAPI 

 

 

 To check the assigned layers, click the Edit Names button in General Settings, as 
shown below. 

 
 

 Tissue Segmentation Detection 

In the Analysis Builder menu, select Tissue Detection as shown below.  Verify that in 
the Select Image Layers, the selected image layers are Vimentin, Bcat, E-Cadherin, 
DAPI.  Verify that Tissue Min Size is 0.  Select the Preview button. (When finished, the 
images will appear blue, as shown below.) 

1) Analysis Builder (Screenshot) with Tissue Detection selected. 
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2) Completed image “Preview” screenshot. 
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 In the Analysis Builder menu, select “Composer: Initialization” (shown below).  Click 
the Preview button (shown below).  The finished images will contain multiple colors 
and segmentation.  Make sure magnification is set at 9.5. 
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 Next on the Analysis Builder menu select “Composer: Training”, as shown below. 

 Under Change Segmentation for all Images, change the Segmentation Scale to 
a value in the range of 3 to 12 and press the Resegment button (refer to image in 
section 7.5.11 above).  Make sure that under Training on the Use Layers drop-
down menu, Bcat is selected.  The segmentation scale may need to be lower if 
the tumor tissue has much stroma within the tumor tissue.  Image layer view 
should be changed to B-cat, and the image display will change from displaying 4 
images to 1 image.  

 Select the Tumor paintbrush button under Sample Selection (refer to image in 
section 7.5.11 above).  Manually select unequivocal areas that are tumor, based 
on β-Catenin positive staining.  This will color tumor area in orange and non-
tumor area in gray.  Shortcut for segmentation: when tumor paintbrush is 
selected, dragging the brush across large areas of tumor will quickly designate 
the tissue rather than selecting each segment individually.  Do this for each of the 
images included in the training set.  A minimum of one training set (12 images) 
must be segmented. 

  Note: Numbers in the image indicate associated SOP steps.   
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 If any segments were mistakenly included and need to be removed, click Erase 

button, and then click back on the segment to be deselected.  Stroma or Glass 
can be designated in the same way using the Stroma paint brush (refer to image 
in section 7.5.11).    

 After all the images have been segmented, press the Learn button.  Review the 
training set images for proper tumor segmentation.  The user may have to adjust 
the segmentation scale (value range 3-12) to properly segment the image.   

The image below shows the tumor segmentation based on β-Catenin signal.  Tumor regions 
are shown in orange and non-tumor are shown in gray. 
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 Evaluation of calibrator tissue and clinical tissues that do not require β-Catenin 
segmentation 

 Tissues in the control slides do not require tissue segmentation.  Tumor tissue is 
distinguished from non-tumor based on DAPI positivity only.   

In addition to control tissue, this approach may be used on clinical specimens 
that have high tumor content, where all of the 20 extracted ROIs contain all 
tumor tissue, as documented in the pathologist review. 

 Under Composer: Training select the DAPI layer.  Make sure the image layer 
view is on the DAPI mask.  

 Change the segmentation scale to “3-12” and re-segment the images based on 
this value.    

 Select the Tumor paintbrush button under Sample Selection and manually select 
DAPI positive regions.   

 To distinguish stroma/non-tumor regions use the Stroma paintbrush to select 
areas of glass where there are no nuclei present.  Only 1 area of glass/or area 
with no nuclei need to be selected per image in training set.   

 Select other areas with nuclei and designate them as tumor.  This may be done 
most easily by visualizing the DAPI channel only during selection of tumor and 
glass.   

 Press Learn button.  The segmentation scale (value range 3-12) may need to be 
adjusted to pick up areas of glass/no nuclei in order to properly segment the 
image.   

 The image below demonstrates how the tissue is segmented based on DAPI 
signal.  The raw DAPI image is shown on the left, the middle image shows the 
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segmented regions denoted as tumor shown in orange and non-tumor shown in 
gray, and on the right is a representative image showing the tumor segmentation 
image created after pressing Learn. 

 

 
 

 Initialize Cellular Analysis 

  In the Analysis Builder, select Initialize Cellular Analysis.  Under Initialize 
Cellular Analysis, enter the following: 

1) If not already checked, under ROI(s) Selection for Cellular Analysis, select 
TUMOR.  

2) Under Magnification for Cellular Analysis, choose 20x for Magnification. 

3) Press the Preview button.  
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     Nucleus Detection 

 Next on the Analysis Builder menu, select Nucleus Detection (shown below), 
and enter the following: 

 
Nucleus Layer DAPI (selected from drop-down menu) 

Membrane <not assigned> 

Nucleus Region Enter a value in the range of 0.1 to 0.98 
(Usually set for 0.68) 

Typical Nucleus Size (μm2) Enter a value in the range of 10 to 220 

(Usually set for 90) 

 



 

31 U.S. Department of Health & Human Services | National Institutes of Health 

 
Note: Numbers in the image indicate associated SOP steps.   

 For nucleus region and size, a suggested range of values are provided based on 
clinical feasibility testing of human FFPE tumor biopsies.  Examples of images 
with proper and improper thresholding are shown below (section 7.5.14.3). 

 When setting the threshold, make sure the entire nucleus is covered by the blue 
mask and that regions in between the nuclei are not covered by the blue mask, 
though some overlap in regions between cells is acceptable.  Below are examples 
of the raw image (A), an under thresholded image (1.3, B), over thresholded 
image (0.1, C), and properly thresholded image (0.5, D).  
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 For nucleus size, a range of 10 to 220 is suggested.  The average nuclear size can 
be approximated by using the Select Samples button (shown below), and then 
choosing 10-12 representative nuclei to get an average size; for best results, 
choose mid to large sized cells, avoiding the smallest or overlapping cells. 

     
 Before selecting preview, switch the training set images to DAPI single layer 

view.  The accuracy of the nuclear segmentation can be assessed in this channel.  
The DAPI mask and nuclear outline masks should be toggled off and on to assess 
the accuracy of nuclear segmentation in the DAPI layer after pressing Preview.    

 The threshold measures the DAPI level, so if shadows of missed cells are 
present, keep the size constant and change the threshold by slowly increasing or 
decreasing the threshold until the faint cells are captured.  On the other hand, if 
one cell is divided into two, keep the threshold constant and change the size 
incrementally.   

 Once the nuclear segmentation is accurate, switch the toggle to multi-layer view 
to view the DAPI segmentation within the β-Catenin staining.  Make sure that 
the multi-layered mixing view is selected, and the lines are off, prior to 
exporting a screenshot by pressing Save Settings and then Apply Settings 
(The Export a screenshot box must be checked).  The multi-layer view will 
allow the user to check the β-Catenin segmentation in the screenshots after 
analysis is completed to QC the image set. 

The image below shows tumor segmentation based on β-Catenin signal.  DAPI images are 
shown with tumor segmentation overlay (top images), and bottom images show the tumor 
segmentation with overlay of DAPI and β-Catenin signals to confirm that the β-Catenin 
segmentation is correct. 
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 Nucleus Morphology Filter (Switch images from multilayer mixing view back to DAPI 
single layer view).  

 In the Analysis Builder menu, select Nucleus Morphology and Filter: In the 
Filter by Feature section, check the box next to Activate, if not already 
checked.  In Feature 1, Area < than 20 should be selected.  Features 2 & 3 are 
not used.  

 If not present, Area can be found by clicking the button with “…” then under 
Object features  Geometry  Extent.  
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 Press Apply button.  Make sure the Remove Excluded Nuc box is not checked.  
Image below shows the resulting segmented nuclei after application of the 
nuclear morphology filter.  Nuclei shown in blue will be included in analysis, 
whereas nuclei shown in gray will not be included in further analysis.            
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 Export a screenshot in the DAPI single layer view by first pressing Save Settings 

and then Apply Settings.  Keep Fill Mask on when saving settings. 

 Marker Area Detection 

7.5.16.1  In the Analysis Builder menu, select Marker Area Detection and define the 
following features for clinical and control slides (refer to image below): 

Marker 1 Vimentin 

Threshold 5000-20,000 

Marker 2 E-Cadherin 

Threshold 5000-20,000 

Marker 3 <not assigned> 

Minimum Area (um2) 5 
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 Check Preview Marker 1, Press Preview.   

 View the marker mask with the Fill option clicked and the Outline option turned 
off (icons shown below). 

                                    
7.5.16.4   Check within the Vimentin image layer whether the RED marker mask 

colocalizes with the Vimentin RGB layer image.  The marker mask for Vimentin 
image layer should cover the regions of positive nuclear signal and be negative 
on regions of background, as shown below (Left - Image; Right - Marker Mask). 
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To improve thresholding, toggle off mask, and place cursor over a place with true but weak 
signal.  The intensity value will be displayed next to the selected area. 

 

 A representative preview RGB image from the Aperio Scan is shown in the top 
panel below.  A representative Definiens marker mask image showing E-
Cadherin in green, Vimentin in red and co-localizing areas in yellow is shown in 
the panel below. 

       RGB Image from Aperio Scan  
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Definiens marker mask image  

 
 If necessary, adjust thresholds until the marker mask colocalizes with the layered 

marker staining.  

 Check Preview Marker 2, and press Preview.  Check within the E-Cadherin 
image layer whether any green marker mask colocalizes with the E-Cadherin 
RGB layer image.  If necessary, adjust the threshold, preview, and repeat until 
the correct threshold is found.  If any changes are made to the initial values while 
adjusting marker thresholds based on the marker layer staining, these new values 
should be noted in the Batch Record. 

 Check Preview Marker 1 and 2, then press Preview.  Representative preview 
images are shown below. 
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 Save Settings and then Apply Settings.  When saving settings, keep Fill mask 

on with E-Cadherin (green) single layer selected.  Exception: if the tumor is 
primarily composed of Vimentin (red) keep the Vimentin single layer with mask 
on when saving settings. 

 Export a Screenshot 

 In the Analysis Builder menu, select Default Export.  

7.5.17.2    Under Default Export, press Save Settings and Apply Settings. See the list of 
settings for all Definiens screenshots in Appendix 6, Section 2. 
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 Select Save Solution (shown below) and save the solution in the header folder.   

 

 
 Run Definiens Analysis 
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7.5.18.1   Click the File tab and select Configure Analysis.  A job scheduler box will 
appear with a drop-down menu.  From the menu, select “http://fr-s-dtp-
378apr:8184”.  Press OK to close box.  

 
 Press the Run Tab and select Analyze All Images from the sub-menu.  When the 

status of the last file changes from Processing to Processed, the quantitation is 
complete.   

 
 

 Reviewing the Results 

7.5.19.1    Review screenshots in the Result > Screenshots > Cellular Analysis folder (as 
shown below).  
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7.5.19.2   In file explorer, view the images by selecting the View tab and Extra Large 
Icons option.  Once the Cellular Analysis folder in the results folder is opened, 
visually inspect each of the EMT masked/gray-scale images to ensure each 
image was analyzed appropriately.  Vimentin should have a red color mask and 
E-Cadherin should have a green color mask.  Make sure normal tissue is not 
included tumor segmentation.  Normal tissue will stain positive for Vimentin; 
therefore the tumor segmentation should be as accurate as possible. 

 

7.5.19.3   If there are segmentation or thresholding issues with more than 20% of the 
images, the workplace should be reset, and a new training set should be selected 
and analyzed* (refer to section 8.2.1.1 for detailed screenshot QC criteria). 
Exceptions to the 20% rule can be made, but it must be listed as a deviation with 
a reason in the Comments section of the batch record (Appendix 1). 

*Shortcut: If, after reviewing the screenshots, it is determined that a new training 
set or different thresholds are needed and the Definiens Architect is still open, the 
workspace can be reset.  Click on the Run tab.  Select “Reset workspace”, select 
existing training set or create new training set.  Go back to the configure tab and 
work down through the script again (section 7.5.6). 
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8.0 QUALITY CONTROL, DATA ANALYSIS AND REPORTING 

 Initiate Data Analysis Template (see Appendix 7 for EMT Master Template Naming 
Instructions). 

 Open the clinical specimen analysis Excel template SOP340548 EMT Master Template 
(available upon request).  The template will be used to analyze the clinical and calibrator 
data.  

 In the Workplace folder go to results > Statistics > 
CellularAnalysis_DefaultExport.report > CellularAnalysis_DefaultExport-per_Slide 
(Excel file – see below).  Copy all the raw data, excluding the headers, for the clinical 
specimens from the Definiens Tissue Studio analysis sheet and paste the data into the 
EMT Master Template on the Original Raw Data sheet.  Copy all the raw data for the 
control slides and paste the raw data onto the CAL Original Data sheet.  Save the EMT 
Master Template and give it a new name with the patient ID and protocol number.  

 
 

 Quality Control Inspection of all Images 

 Quality Control Evaluation of Screenshots 

 Within the Definiens analysis open the results > Screenshots > Cellular Analysis.  
Visually inspect every screenshot for the clinical tissue to ensure the following 
criteria are met:  1) The β-Catenin segmentation reflects accurately that only β-
Catenin positively stained tumor tissue is included in the analysis (refer to 
section 7.5.14.7 for example of correct β-Catenin segmentation); 2) The nuclear 
segmentation accurately depicts DAPI positive nuclei (refer to section 7.5.14.3 
examples of under, over and properly thresholded nuclei).  If either the tissue or 
nuclear segmentation is not accurate, the analysis should be refined and re-
run;  and 3) Ensure that the marker threshold accurately captures marker positive 
cells.  Examples of correctly and incorrectly segmented tissue are shown below.  
The criteria for acceptable segmentation are that the image has a maximum of -/+ 
10% of the tumor area and/or of the marker area over or under thresholded.  If 
the marker mask is detecting signals other than tumor cell specific expression 
(i.e., collagen, auto fluorescence, tissue folds, any features that interfere with 
nuclear detection), those images should be noted for removal from analysis. 
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 After reviewing the images as stated above, the data for the images to be 
removed from the final analysis should be highlighted in the Original Raw Data 
sheet of the EMT Master Template.  Do not remove the data from the Original 
Raw Data sheets. If more than a few images are to be removed, it is good 
practice to make a note as to why the images were not included in the analysis. 

 Copy the Original Raw Data sheet, with the highlighted rows indicating any 
image data to be removed, and paste the data into the Raw Data2pass sheet.  
Delete all highlighted rows from the Raw Data2pass sheet.  

 Review the control slide images from Definiens.  If, after reviewing the images, 
there are images that are deemed to be outliers for the control tissue, highlight 
the row of data that is to be removed in the CAL Original Data sheet.  Do Not 
Remove the data from the CAL Original Data Sheet. 

 Copy the data from CAL Original Data sheet and paste it on the CAL Data 
sheet.  Delete all highlighted rows from the CAL Data sheet.  
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 Select the Developer tab and click on Macro.  In the drop-down menu, select 
EMT2Pass.  After the run is done, save the EMT Master Template. (If the Developer tab 
is not visible, it will need to be enabled.) 

 Check all pages for errors.  For example, the Lookup 2pass sheet shows the total image 
number.  Compare the total image number to the number of raw data images analyzed.  
Make sure that on the Template 2pass and Cal Summary sheets the data is present in 
all cells that should contain data. 

 EMT Control Slide QC 

 Variability in sample processing and staining is monitored by employing assay specific 
control slides.  At least one EMT control slide should be included in each clinical 
staining run, and it should be evaluated to confirm that biomarker levels fall into the 
acceptable range.  The Control Slide layout and tissue description are provided in 
Appendix 2. 

 The acceptable range for biomarker levels for the tissue control slides is determined by 
lot, and will be set for Log10 of V:E (Vimentin Area : E-Cadherin Area) for all the tissues 
on the control slide.  All tissues (epithelial, mesenchymal and the E/M mix control) on 
the control slide should pass QC in order to proceed to reporting of clinical analysis data.  
A minimum of 5 ROIs from each control tissue should be analyzed.  

 The lot number and the image ID of the tissue control slides will be part of the image 
name, thus will be captured on the EMT Master Template.  

 If the control slides meet the defined criteria above, proceed to the evaluation of the 
clinical slide QC.  If the control slides do not meet the criteria above, the assay fails QC. 
Check for errors in data acquisition, labeling and analysis of the QC slides.  If no errors 
are found, the assay should be rerun using a backup clinical slide set and fresh control 
slides. 

 In some cases, there may be an isolated control tissue failure that is tissue specific.  If all 
other control tissues pass on the control slide, and the failure to achieve the expected 
Log10 of V:E for one tissue is thought to be tissue specific and not an assay failure, the 
Laboratory Director/Supervisor may allow exceptions to the QC.   

 EMT Clinical Slide QC 

 The clinical slide layout and tissue description is provided in Appendix 2. 

 Each clinical slide typically contains two to three time point biopsies with 1-2 passes for 
each time point, and a positive fixation control for the EMT tissue (mouse jejunum).  
The positive control should be assessed qualitatively on each slide.   

 As described in SOP340550, murine jejunum tissue is fixed and processed in parallel 
with the clinical biopsies.  This tissue serves as a control for proper tissue fixation and 
staining for the EMT Panel IFA.  E-Cadherin staining is positive in the epithelial cells 
lining the villi.  β-Catenin stains all the cells that comprise both the crypts and the villi.  
Vimentin staining should be negative for all the cells in jejunum.  Note: murine testis 
tissue is also included for tissues processed under SOP340550, however there are no 
requirements for this tissue for the EMT panel IFA. 

 If the expected staining patterns for E-Cadherin, Vimentin and/or β-Catenin are not 
confirmed by qualitative analysis of the murine jejunum section on the clinical slide, the 
slide should not be evaluated, and the potential source of the problem should be 
investigated. 
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 A minimum of 6 ROIs for each biopsy tissue from at least two non-adjacent slides for 
each patient with a minimum of 3000 nuclei/tissue for 2 slides are required to report 
quantitative clinical slide data.  If this number of nuclei is not achieved for a clinical 
tissue, additional slides can be run and analyzed.  

 Finalizing Data Report and Batch Record 

 Completion of Data Report 

 Before completing the sample Data Report make sure there are no errors on the 
EMT Master Template by reviewing all generated sheets. 

 Complete the Data Report sheet by filling in the name of the operator and the 
date of the report.  Make sure the calibrator data passed.  The limits for Cal 1 & 
Cal 3 and the Vimentin & E-Cadherin image exposure times, and Definiens 
Architect Analysis Vimentin & E-Cadherin thresholds must be entered manually 
on the CAL Summary sheet.  The calibrator pass/fail status will automatically 
be displayed on both CAL Summary and Data Report sheets as long as the 
limits are entered.  

 Review the nuclei number for each pass to determine if the minimum of 3000 
cells / 2 slides were met.  If less than 3000 cells were analyzed, DO NOT 
REPORT THE DATA for that pass.  

 In the Comments section of the Data Report list any deviations or problems 
that occurred.  

 Review Data Report for accuracy and completeness.  

 The Data Report is not complete until the supervisor signs the report.  By 
signing the Data Report, the supervisor or reviewer indicates that the Data 
Report is both complete and accurate.  Save the completed EMT Master 
Template in the appropriate header folder.  The Data Report can be signed 
electronically; if, instead of the electronic version, a paper copy of the Data 
Report is signed, scan the signed paper copy.  The scanned Data Report must 
be kept in the header folder.  

 See Appendix 3 for blank Data Report.  See Appendix 4 for an example of a 
completed Data Report.  Appendix 5 shows the calculations used to generate the 
Data Report.  

 Completion of Batch Record 

 Make sure to complete the Batch Record, including filling in name of the 
facility/lab analyzing the images, date of the analysis, name of the operator 
preforming the analysis, CTEP protocol number, patient ID, slide numbers, tissue 
(pass) IDs, calibrator lot number and image ID (Appendix 1). 

 Record, for both the calibrators and clinical tissues, the threshold settings for 
Vimentin and E-Cadherin used in the Definiens image analysis (Appendix 1). 

 Record the names and the location of the header folder.  

 Document ALL deviations from this SOP in the Comments section of the Batch 
Record (Appendix 1). 

 Review finalized Batch Record for accuracy and completeness and obtain 
required signature with date. 
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APPENDIX 1: BATCH RECORD  

1. Image Extraction and Analysis 

Facility/Lab Name:  Date(s):   

Assay Operator:   Patient ID and  
Tissue ID(s):  

 

CTEP Protocol#:  Calibrator Lot#:  

Calibrator Image 
ID(s): 
 

 Thresholds: 
(Calibrator) 

Vimentin  

E-Cadherin  

Patient Slide #: 
 

 Thresholds: 
(Patient) 

Vimentin  

E-Cadherin  

Name of Header 
Folder*: 

 

Location of Header 
Folder:  

 

* EMT Master Template /Data Report must be kept in Header Folder 

2. Comments: 

 

 
 

Signature:  
______________________________      Date:  

___________ 

 (signature indicates that the information in the batch record has been reviewed and verified) 
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APPENDIX 2: CONTROL SLIDES AND CLINICAL SLIDES LAYOUT 

1. Control Slides 

a) Day-to-day variability in sample processing and staining is monitored by employing a 
control slide run with each clinical staining and analysis for the EMT panel IFA.  One 
control slide is required for each set of patient slides and should be run on the same tray of 
a Bond-RX run as the patient slides.  

Control slide layout  

 
 Example of Control Slide 

 
b) Control sections are generated from NBF-fixed, paraffin-embedded, untreated xenograft 

tissues or cell pellets from A. HT29, B. SUM-149-PT and C. MDA-MB231. Liver control 
tissue (red) is included for orientation. 

c) The positive staining control for E-Cadherin (AF488) and β-Catenin (AF546) is the HT29 
tissue (A).  The positive control for Vimentin staining is the MDA-MB231 tissue (C).  The 
SUM-149-PT tissue (B) represents a mixture of epithelial and mesenchymal cells and 
should therefore have staining for both the E-Cadherin and Vimentin biomarkers. 

d) The negative/low control specimen for Vimentin is the HT29 tissue, while the 
negative/low control for E-Cadherin is the MDA-MB231 tissue.  β-Catenin is present in all 
control tissues and there is no designated negative control for β-Catenin. 

e) Acceptable ranges for Log10 of V:E will be set for all the tissues on the tissue control slide 
and determined by lot.  All control tissues on the slide must pass QC to proceed to the 
clinical analysis.  A minimum of 5 images from each calibrator tissue should be analyzed 
(one image represents one data point).  

f) Representative data and image of the control slide can be seen above.  
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2. Clinical Slides 

a) The layout for the clinical slides with 1 or 2 passes is shown below.  The first time point 
biopsy is processed and blocked together with a mouse jejunum (testis is also often 
included as it is a control for related pharmacodynamic assay panels).  The second time 
point biopsy is processed and blocked in a separate block without any other tissues.   

  
b) The EMT positive fixation control specimen is mouse jejunum.  In a tissue cross-section, 

E-Cadherin staining is positive in the epithelial cells lining the villi, and β-Catenin stains 
all the cells that comprise both the crypts and the villi.  Vimentin staining should be 
negative for all the cells in jejunum.  

c) Clinical samples for this assay will be frozen needle biopsies collected per SOP340507, 
embedded and sectioned per SOP340550, and stained for the EMT Panel per SOP340546.  

d) Backup slides are available for use if the first slide set does not meet QC criteria for the 
EMT Panel. 
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APPENDIX 3: BLANK DATA REPORT GENERATED IN THE TEMPLATE MASTER 
(AREAS COLORED IN YELLOW MUST BE COMPLETE FOR THE FINAL DATA REPORT) 
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APPENDIX 4: EXAMPLE OF A COMPLETED DATA REPORT GENERATED IN THE EMT TEMPLATE 
MASTER  
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APPENDIX 5: SAMPLE DATA REPORT CALCULATIONS 

A. Log10 (V:E) – Calculated for each ROI, and for both the mean per slide and the mean of all 
imaged slides combined for each time-point pass. 
1. Calculate the Total Area (um2) per nuclei (cell) for Marker 1 (Vimentin) and Marker 2 (E-

Cadherin).  
Total Area = Total Area of Marker/ # of nuclei evaluated (includes colocalization) 

2. Total Area for each Mark of 1000 cells = Total Area for Marker X 1000 cells. (For total areas 
that are less than one, the number one will be recorded and used in the calculations for Log10 
(V:E). 

3. Log10 (V:E) =  Log10(Total Area of 1000 cells Marker1/ Total Area for 1000 cells Marker2) 
4. Calculate the mean and the mean standard deviation of the Total Area of Each Marker and for 

the Total Log10 for all imaged slides. 
5. Add the total number of nuclei (cells) analyzed for each time-point pass.  

B. V/E Colocalization – Calculated for each ROI, and for both the mean per slide and the mean of 
all imaged slides combined for each time-point pass 
1. Calculate the V/E Overlap Area (um2) per cell = Overlap Area/total # nuclei  
2. Calculate Marker 1 & Marker 2 Area per cell = (Marker area – Overlap area)/ total # nuclei 
3. Calculate the mean and the mean standard deviation for V/E Overlap only, the Vimentin only 

and E-Cadherin only areas per cell. 
C. Area % for Vimentin only, E-Cadherin only, and V/E Overlap only - Calculated for both the 

mean per slide and the mean of all imaged slides combined for each time-point pass 
1. Calculate % Area for Vimentin only, E-Cadherin only, and V/E overlap only per slide. 

% Marker Area per slide = (Mean Area for a Marker for each slide/ Mean of the sum of the total 
area for each slide) x 100% 

2. Calculate % Area for Vimentin only, E-Cadherin only, and V/E overlap for all slides per time-
point pass 
% Total Area for Timepoint pass = (Mean of Area for Marker for each time-point pass/ Mean of 
the sum of the total area for each time-point) x 100% 

D. Area for Vimentin only, E-Cadherin only, and V/E Overlap for total nuclei - Calculated for 
both the mean per slide and the mean of all imaged slides combined for each time-point pass 
1. Calculate Total Area for each Marker for all nuclei for each slide pass = Mean of the Area for 

Marker for each slide pass x Sum of the total # nuclei for each slide pass 
2. Calculate Average Area for each marker for all nuclei for each time-point pass= Mean of the 

Marker Area from all slides for each time-point x all nuclei from all slides for each time-point 
pass 

E. Total Number Cells Positive for Vimentin only, E-Cadherin only, and V/E Overlap 
1. Total number of Positive Cells for each Marker per time-point = Mean % Area for the Marker for 

all Sides passes x the sum of the total # nuclei for each time-point pass. 
F. Total Area of Nuclei for each Cell Type (Vimentin, E-Cadherin, and V/E Overlap) 

1. Marker Overlap Area (um2) per cell = Marker Overlap Area/# nuclei 
Marker Area (um2) per cell = (Marker Area – Overlap Area)/# nuclei 

2. Average Marker Area Overlap/Nuclei for each slide/timepoint/tissue 
Average Marker Area Vimentin/Nuclei for each slide/timepoint/tissue 

3. Sum Avg Marker Areas/Nuclei for each pass 
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APPENDIX 6: LIST OF HEADER FOLDER CONTENTS & LIST OF SETTINGS (EXPORT A 
SCREENSHOT) IN DEFINIENS 

 
 List of files/folders that should be placed in the Header Folder. 

 

 

 List of settings for Exported Screenshots in Definiens.  

a) Nucleus Detection – Mix Layer, Mask on, Lines off 

b) Nucleus Detection – DAPI Single Layer, Mask on, Lines on 

c) Marker Area Detection – E-Cadherin single layer, Mask on, Lines off 

d) Default Export – Save and Apply as is.  

 

 Other reminders 

• 6-20 images per clinical tissue 

• 3000 nuclei/tissue per 2 slides for clinical tissues 

• <3000 nuclei/tissue per 2 slides cannot be reported 

• A minimum of 5 images per tissue per calibrator slide 

Spreadsheet (Template) can analyze up to 2 passes for 3 timepoints each with 30 images per 
tissue per slide. Six is the maximum number of slides that can be run in the template.  
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APPENDIX 7: NAMING ANNOTATED ROI 

1. Naming guidelines for clinical ROIs, as specified below, must be followed to ensure that the template works 
correctly.  

Example of extraction naming: 09659_0029 502D Slide 015 C1D08 01 

a. First part of the name is the project number. The project number must be 5 digits in length; enter a “0” in 
front of a 4-digit project number.  Abbreviate project numbers longer than 5 digits.  In the above example, 
the project number is 9659, and a zero was added to make it 5 digits. 

b. After the project put an underscore, and then the patient number.  The patient number must be 4 digits in 
length; for numbers less than 4 digits, enter zeros before the number.  In the above example, the patient 
number is 29, and two zeros were added in front of the number to make it 4 digits.  

c. After the patient number put a space, and then the specimen ID.  The specimen ID is 4 digits in length. In the 
above example, the specimen ID is 502D.  

d. Next, leave a space and write the word “Slide”.  After the word slide, leave a space and put the slide number. 
The slide number must be 3 digits long; for slide numbers less than 3 digits, add zeros before the number to 
make it 3 digits.  In the example above, the slide number is 15, and a zero was added before the number to 
make it 3 digits long.  

e. After the slide number, leave a space and put the timepoint.  The timepoint must be 5 digits; use zero to make 
the timepoint 5 digits long.  In the above example, the timepoint is cycle 1 day 8, and a zero was added 
before the 8 to make 5 digits.  

f. After the timepoint, leave a space and put the 2 digit image ID.  If the image ID is less than 2 digits long, add 
a zero in front of the number.  In the above example, the image ID is 1, and a zero was added in front of the 1 
to make it 2 digits long.   

2. Naming rules for Calibrator ROIs, as specified below, must be followed:     

Example of extraction naming: 00019382 19000096 EMT Cal1 01 

a. The name starts with the image ID.  The image ID must be 8 digits in length; for image IDs less than 8 digits 
long, add zeros before the number.  In the example above, the image ID is 19382, and zeros were added to 
make the number 8 digits in length.  

b. Leave a space after the image ID and put the lot number.  The lot number must be 8 digits in length.  In the 
above example the lot number is 19000096. 

c. After the lot number leave a space and type the word “EMT”. 

d. After EMT, leave a space and put Cal1, Cal2, or Cal3. 

e. After the Cal number, leave a space, and then put the image ID.  The image ID is 2 digits; for image IDs 
fewer than 2 digits, put a zero in front of the number. 
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